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Part 1 - Designing a Privacy Screen 

The purpose of this exercise is to draw the following privacy screen based on an environment. 

 

Concepts addressed: 

- Using the Building command 
- In-place design 
- Using assembly kits 
- Performing trimming operations while keeping the trimmed side 

Creating the project 

• From the TopSolid 7 home page, click on the  New Project icon. 

• From the Steel Templates folder, select Design Template, rename the project Advanced TopSolid'Steel Training, 

then click on  to confirm the operation. 

• In the Project tree, create a first folder named 1- Privacy screen. To do this, right-click on the Advanced 

TopSolid'Steel Training project name and select the  Folder command. 
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Designing the environment using the Building command 

 

• Right-click on the 1- Privacy screen folder and select the  Assembly command. 

• Right-click on the new assembly document and select the  Properties command. 

• Click on the Edit button. 

• Enter Environment in the Description field and click on  to confirm the operation. 

During the basic session of TopSolid, we saw how to create an environment with standard modeling commands. 

TopSolid'Steel also integrates a simplified drawing tool to create buildings. 

• From the Modeling tab, select the  Building command. 

• In the Building section, enter 2 in the Level count field and 250cm in the Default height under ceiling field. 

• In the Walls section, select the Wall family and enter 200mm as the default thickness. 

• In the Slabs section, select the Slab family and enter 200mm as the default thickness. 

The Positioning section deals with the positioning of the building. 

• Keep the default values. 

In the Advanced Options section, the Imprint walls on slabs option allows you to divide the slab into zones. This 
can be useful to retrieve a surface or create a coating quickly. 
The Extend exterior walls option allows you to hide the slab with the walls. This is purely for aesthetic purposes 
and does not affect the different dimensions in any way. 

• Uncheck the Extend exterior walls box. 

• Click on  to confirm the Building command. 

TopSolid switches to the sketch context for the walls. The aim here is not to complete the design of the entire 
building but simply the area concerned by the work. 
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• Select the  Rectangle command and draw the following rectangle. 

 

TopSolid draws the walls dynamically with graphic handles. 

 

Note: The yellow arrow indicates the outside of the wall: the point corresponds to the outside and the base 
corresponds to the inside. By clicking on this arrow, you can flip the wall. 
The spheres allow you to change the alignment of the wall in relation to the created segment. 

• Double-click on one of the walls to display the wall properties. 

The Wall properties command allows you to make local or global changes. You can therefore modify the thickness, 
the height, the alignment or even the drivers on the Wall component (family). 

• In the Walls field, select all the walls. 

• In the Alignment section, select Exterior Face. 
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• Click on  to confirm the operation. 
 

• Add the two segments as shown below. 

 

• Select the  Trim command. 

• Activate the Divide mode and click on the left part of the horizontal segment. 

 

The wall is then divided into two parts. 

• Select the three interior walls, then right-click and select the Wall Properties command. 

• In the Thickness section, select the Manual mode and enter 70mm. 

 

• Click on  to confirm the operation. 
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• Right-click in the graphics area and select the Edit Slab command. 

TopSolid automatically generates a profile that includes all the walls. 

 

We will now move on to the next level. 

• Right-click in the graphics area and select the Edit Walls of Upper Level command. 

TopSolid automatically uses the same walls as for the lower level. You can modify this level completely 
independently. 

• Delete the coincidence constraint as shown below using the Del key on the keyboard or the  Delete 
command from the contextuam menu. 

 

• Offset the wall upward and add the dimension as shown below. 
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• Right-click in the graphics area and select the Edit Slab command. 

• In the same way as for the walls, offset the edge of the slab toward the outside. 

 

• Confirm the sketch. 

You should obtain the following result. 

 

A simple and clear structure of the building is constructed in the Parts tree as well as in the Entities tree. 

 

•  Save the document (Ctrl + S). 
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Designing the privacy screen 
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The privacy screen will be designed using parametric components whose design principles will be described 
throughout the rest of the training. 

• Right-click on the 1- Privacy screen folder and select the Import/Export >  Import Package command. 

• Select the package named Privacy Screen Components.TopPkg. 

Reminder: This import method allows you to copy the contents of the package locally to a project folder. Only the 
elements resulting from the projects can be copied in this way. The elements from libraries are imported as libraries. 

• Right-click on the 1- Privacy screen folder and select the  Assembly command. 

• Right-click on the new assembly document and select the  Properties command. 

• Click on the Edit button. 

• Enter Privacy screen in the Description field and click on  to confirm the operation. 

• Click on the  TopSolid 7 icon at the top left of the screen and select the File >  Background Document 
command. 

• Select the Environment document and click on  to confirm the operation. 
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Creating the outer frame 

• Select the Construction >  Midplane command, then select the planes as shown below. 

 

• Create the following sketch on the previously created plane. 
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The orientation of the sketch does not matter (wall on the left or right). However, if you want to reorientate the 

sketch, you only have to select the  Position Sketch command and click on the  icon to the left of Plane 1. 

 

For the 30° angular dimension, you can use an existing horizontal segment or use the virtual X axis. To do this, when 

setting the dimension, you can either click on the  Angle with X button in the Constraint dialog box or use the 
contextual menu. 

 

The sketch must be completely blue. 

• Confirm the sketch. 

• Hide the background document using the contextual menu or from the Entities tree. 
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• Select the Modeling >  Extruded Bar command. 

• Select the whole sketch, then select the Hollow Rectangle Section, ISO 4019 family and the 80 x 40 x 2 code. 
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• Right-click on the extruded bar as shown below and edit it. 

• Replace the family with Full Wide Flat, NF A 45-005 and the code with 160 x 15. 

• Position the extruded bar as shown below. 

 

 

• Repeat the operation on the following extruded bar. 
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You should obtain the following result. 

 

•  Save the document (Ctrl + S). 

• Right-click on one of the extruded bars and select the  Miter Trim command. 

• Select the three extruded bars as shown below. 

 

• Perform  main trims on the following extruded bars. 
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• Finish the operation by performing a miter trim. 

 

Creating the filling 

We will now build the internal structure that will support the sheet metal parts. 

• Create a new sketch on the following plane. 
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• Select the  Project command and select the following edges to form a frame. 

 

Once the operation has been confirmed, you should obtain the following result. 

 

Reminder: The vertices circled in green indicate the openings of a profile. 
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• Select the  Trim command and click on the segments as shown below. 

 

 

• Select the  Offset command. 

• Select the frame and enter a distance of 1mm. 
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• Add a segment centered on the lower segment. 

 

• Confirm the sketch. 
 

• Position two Full Flats, NF A 45-005 extruded bars using the 40 x 5 code on the following segments. 
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• Add a Hollow Rectangle Section, ISO 4019 extruded bar using the 40 x 20 x 3 code on the center segment. 

 

• Use the Orientation field to adjust the positioning angle. 
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The extruded bar must be centered on the segment. 

 

• Add two Full Flat, NF A 45-005 extruded bars using the 40 x 10 code on either side of the tube. 

• Add a 10mm offset if you are using the center segment of the sketch as the positioning profile. 
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Since the rectangular extruded bar will be welded to the frame, you have to extend it at the ends so that it will be 
in contact with the frame. 

• Right-click on the extruded bar and select the  Main Trim command. 

• Perform the operation on the top and bottom. 
 

 
 

 

• From the Project tree, open the 1- Privacy screen > Privacy screen components > Sheetmetal with pattern 

folders, then drag and drop the  Family document named Sheetmetal with pattern into the assembly's 
graphics area. 

Note: Families are parameterized components in TopSolid, which have variables called "drivers". These drivers can 
be of any type (digital, text, material, coating, etc.). 

 

In this case, the Sheetmetal with pattern component allows you to select its height and width. An image is available 

to help you understand what these values represent and can be hidden using the  icon. 

You can synchronize the Height and Width values with the frame. Modifying the dimensions of the frame will 
automatically modify the sheet metal part. 
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• In the Height field, click on the  icon and select the Associative value option. 

• Select the left segment of the sketch. 

 

• Repeat the operation with the Width field by selecting the horizontal segment of the sketch. 

 

• Click on  to confirm the inclusion. 

TopSolid switches to the positioning context. 

• Add constraints to position the sheet metal part as shown below. 
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• Enter 1mm offsets to keep a clearance. 

  

• Confirm the positioning. 

• Select the Modeling >  Trim by Profile command. 

• First, select the sheet metal part as the part to modify, uncheck the Straighten lateral faces advanced option, 
then click in the Section field and select sketch 2's frame using the rotary picking technique. 

 

Note: Deactivating the straightening of the side faces is not mandatory, but this operation requires significant 
resources in the case of perforated sheet metal parts. In fact, TopSolid tries to straighten each face of the part and 
spends an unnecessary amount of time on each opening. It is therefore advisable to uncheck the box when it is not 
necessary. 

• Click on  to confirm the trimming operation. 
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TopSolid indicates that the part must be derived for modification. 

• Click on OK. 

 

• Select the derivation template as shown below. 

 

This template will allow you to modify the description of the sheet metal part. In this way, you will have a left sheet 
metal part and a right sheet metal part. 

• Select the Modeling >  Trim by Profile command. 

• First, select the sheet metal part as the part to modify, uncheck the Straighten lateral faces box and check the 
Keep trimmed side box, then click in the Section field and select the vertical center segment of sketch 2 using 
the rotary picking technique. 

 

• Select the Partial Part (New description) document template to be used for the trimmed side. A partial part 
means that a single part becomes several parts.  
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Integrating fastenings 

We will now integrate the different fastening elements using the Assembly Kit command. 

• From the Entities tree, display the background document. 

• From the Project tree, open the 1- Privacy screen > Privacy screen components > Anchor Bolt Kit folders, then 

drag and drop the  Family document named Anchor Bolt Kit into the assembly's graphics area. 

The Assembly Kit command starts automatically. 

• Select M12 x 145 as the code, select an edge of the lower right-hand plate as the direction, and then select the 
contact face between the plate and the environment as the first face. 

 

Note: Assembly kits are tailor-made components that can be designed by everyone. The method used to create 
them will be explained throughout the training course. 

The calculation of the assembly kit distribution is based on the Eurocodes. The distribution depends on the diameter 
of the anchor bolt, the thickness to be clamped and the dimensions of the element to be fixed. You can adjust the 
result in the Optional Drivers tab. 

• Click on  to confirm the inclusion. 
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TopSolid then offers to create the associated process. 

• Select Slotted Clearance Hole from the Process drop-down list. 

This process has drivers that can be modified as needed. The adjustments and dimensions of the oblong hole are 
also based on the Eurocodes. 

Warning: The Eurocodes start from size M12. Therefore, this process cannot be used on smaller diameters. 
However, you can edit this by copying and editing the Clearance Hole Standard EN 1090-2 documents (TopSolid 
Mechanical library), as well as the desired processes. 

• Repeat the procedure on the upper plate. 

 

We will now fix the two flat sections on the central rectangular extruded bar. To save time, we will install several 
kits at the same time. 

• From the Project tree, open the 1- Privacy screen > Privacy screen components > Screw Kit folders, then drag 

and drop the  Family document named Screw Kit into the assembly's graphics area. 

The Assembly Kit command starts automatically. 

• Select the Multiple mode. 

• Select the M6 x 16 code, select a vertical edge of one of the flat sections as the direction, then select the two 
flats and the rectangular tube as the parts to assembly. 
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• In the Optional Drivers tab, enter 5 in the Number of screws on height field. 

• Click on  to confirm the inclusion and the process. 

You should obtain the following result. 

 

We will repeat the operation on the two flat sections that are fixed to the outer frame. 

• From the Project tree, open the 1- Privacy screen > Privacy screen components > Screw Kit folders, then drag 

and drop the  Family document named Screw Kit into the assembly's graphics area. 

• Select the M6 x 16 code and select a vertical edge of one of the flat sections as the direction. 

By default, the assembly kits automatically detect the contacting faces. In this case, a clearance exists between the 
plane and the outer frame. 

• To force the system, click in the First face field, position the cursor as shown below, then select the contact 
face between the flat section and the tube using rotary picking. 

• Repeat the operation with the Second face field. 
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• In the Optional Drivers tab, enter 5 in the Number of screws on height field. 

• Click on  to confirm the inclusion and the process. 

• Repeat the operation on the other side. 

  

Defining the sub-assemblies (in-place assemblies) 

• Select the Modeling >  In Place Assembly command. 

• Create the following three sub-assemblies. 

   

The modeling is now complete. You can vary the environment as well as the different sketches to reset the 
dimensions of the privacy screen as you wish. 

• Edit sketch 1 and modify the following dimensions: 

- 2000mm → 1800mm 
- 1600mm → 1300mm 
- 150mm → 250mm 
- 30° angle → 45° 
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• Confirm the sketch. 

TopSolid recalculates the entire privacy screen (structure, sheet metal part, screw distributions, etc.). 
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Part 2 - Designing a Spiral Staircase 

The purpose of this exercise is to draw a parametric base of a spiral staircase as shown below. 

 

Concepts addressed: 

- Parameterization 
- Sheet metal work 
- Helical pattern 

Creating the basic parameters 

• From the Project tree, create a new folder named 2- Spiral staircase. 

• In this folder, create a new  Assembly document named Spiral staircase. 

• From the Entities tree, right-click on the Parameters folder and select the  Real Parameter command. 

Reminder: The real parameters are the most common parameters. They can be of any type (length, angle, without 
unit, surface, etc.) and can themselves integrate formulas. For more experienced users, it is possible to integrate 
VB.net or C# scripts. 

• Select Length as the type, enter TotalRise as the name and a value of 3000mm. 

•  Pin the command's dialog box and click on  to confirm the operation. 

• Create a StepRise parameter using the Length type and enter a value of 175mm. 

• Click on  to confirm the operation. 

• Create a StepNumber parameter using the Factor type and enter the following formula as the value: 
TotalRise/StepRise. 
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TopSolid integrates a system to control and constrain the results. 

• Select the  Constraints dialog box. 

• Select the Solve mode. The value will be automatically adjusted. 

• In the Discretization section, enter 1 in the Step field and select Superior value from the Solving drop-down 
list. 

 

• Click on  to confirm the operation. 

Factor parameters contain values without units and can be used as coefficients, to manage quantities, etc. 

• Create the following parameters. 

Parameter 
type 

Name Value/formula 

Length StepRiseReal TotalRise/StepNumber 

Length Headroom 2000mm 

Factor RevolutionNumber TotalRise/Headroom 

Angle StepAngle 360 * RevolutionNumber/StepNumber 

Length ExternalDiameter 2000mm 

Length TreadingDiameter ExternalDiameter * (2/3) 

Length ProjectedTreadingLength pi * TreadingDiameter 

Length StepWidth 
ProjectedTreadingLength * 

RevolutionNumber/StepNumber 
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• Select the Construction > Patterns >  Helical Pattern command to create a new helical pattern and adjust 
the parameters as shown below. 

 

Note: Creating the pattern prior to performing the repetition offers some advantages over creating it on-the-fly 
when performing the repetition operation. 

- This allows you to see the pattern result before designing the staircase. 
- This allows you to create a parameterized base containing everything you need to create the staircase. 
- If the repetition is deleted, the pattern remains.  
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Creating the central post and steps 

• Select the Modeling >  Extruded Bar command. 

• Select the Hollow Circular Section, ISO 4019 family and the 193.7 x 5 code. 

• Select the  Frame and Length mode. 

• In the Destination frame field, select Absolute Frame. 

• In the Length field, enter TotalRise + 1000. 

 

• Click on  to confirm the operation. 
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• Select the Construction >  Offset Plane command. 

• Select XY Plane as the reference plane and the StepRiseReal parameter as the offset distance. 

• Right-click on the previously created plane and select the  In Place Part command. 

• Draw the following sketch. 

 

The Ø193.7 dimension is a projection of the central post's external diameter performed using the  Project 
command. 

To retrieve the parameters of the assembly, you only have to: 

- create the dimension; 

- click on the  icon and select the  Real Relay Parameter command; 

- select the desired parameter from the Parameter drop-down list and click on  to confirm; 

- click on  to confirm the dimension again. 

Note: There is an alternative solution to the relay parameters. To retrieve a parameter from the parent assembly, 
you only have to enter ParentName:ParameterName in the Value field of the dimension. 
Example: Spiral staircase:TreadingDiameter 

• Hide the assembly context by clicking on the  icon at the top right of the graphic area, then by selecting 

 Hide Editing Context. 
 

 Hide Editing Context Allows you to hide the assembly during in-place editing. 

 
Show Editing Context 

Allows you to display the assembly during in-place editing 
without the ability to hook onto it. 

 
Activate Editing Context 

Allows you to display and use the assembly during in-place 
editing. 
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• Create an  offset based on the following segment. Use rotary picking to select this segment. 

 

• Adjust the ends by dragging the points onto the inner and outer circles. 

 

• Hold down the Ctrl key and select the lines as shown below, then select the  Construction command to 
convert them into construction lines. 
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• Select the  Trim command and delete the segments to obtain the following result. 

 

• Right-click in the graphics area with no active selection and select the  Sheet Metal on Sketch command. 

• Enter a thickness of 5mm and click on  to confirm the operation. 

 

• Add two  80mm flanges as shown below. Make sure you check the Create sketches box. 
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• Via the  Width dialog box or the contextual menu, make sure that the Bend transition option is set to 

 Adjusted mode. 

 

• Click on  to confirm the operation. 
 

• Double-click on one of the previously created flanges. A sketch is displayed. 

 

• Right-click on the sketch and select the  Edit command. 

• Remove the orientation constraint as shown below, as well as the 75mm dimension. To do this, select the 

element and press the Del key, or right-click on the element and select the  Delete command from the 
contextual menu. 

 

• Offset the line so that it is no longer horizontal, then add the two dimensions as shown below. 

 

• Select the 2D Sketch >  Deformation command. Click on the segment as shown below. Hold down the left 
mouse button and move the cursor upward. The segment becomes distorted and turns into a circular arc. 

• Add a perpendicularity constraint on the left vertex of the arc as shown below. To do this, right-click on the 

vertex and select the  Perpendicular command. 

 

• Confirm the sketch. 
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• Repeat the operations on the second bend. 

You should obtain the following result. 

 

• Add two 50mm flanges on the segments as shown below with an angle of 88°. 

 

• Add a Ø8 drilling centered on each of the previously created flanges. 

  

• Confirm the in-place editing of the part. 
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• Select the Construction >  Repetition command. 

• Select the step as the entity. 

• Select Pattern 1 as the pattern to be used. 

 

• Click on  to confirm the repetition. 

The base of the staircase is now complete. 

You can vary the TotalRise, StepRise, Headroom, and ExternalDiameter parameters to test your parameterization. 
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Creating the external stringboard 

• Select the 3D sketch >  Helix command. 

• In the Radius field, enter the formula ExternalDiameter/2. 

• In the Longitudinal pitch field, select the Headroom parameter. 

• Select the point shown below as the first point. 

 

• Select the following point as the Z point (vertical). 
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• Select a point in the void approximately in the area shown below. 

 

• On the base of the helix, add a 20mm dimension between the bottom vertex of the helix and the front plane of 
the step. 

 

• Add a coincidence between the top vertex of the helix and the arrival plane of the staircase. 
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• Select the  Edge Copy command and select the segment as shown below. 

 

• Edit the coincidence of the previously created segment to make it coincide with the top vertex of the helix. 

 

• Confirm the sketch. 

• Right-click in the graphics area and select the  In Place Part command. 
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• Select the Shape >  Extruded command. 

• In the Section field, select the previously created sketch. 

• In the Direction field, select the absolute Z axis or the central post axis. 

• Extrude 270mm downwards with an offset of 20mm. For the offset, you can move the yellow sphere directly 
into the graphics area. 

 

• Click on  to confirm the extrusion. 

• Right-click on the created shape and select the  Sheet Metal by Thickening command. 

• Enter a thickness of 4mm toward the outside. 
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• Select the Shape >  Trim command. 

• Trim the stringboard in relation to the XY plane or the base of the central post. 

 

For this type of part, it is often necessary to provide an extra rolling length. 

• Select the Sheet Metal >  Forming Flange Straightening command. 

• Select the  Extension on unfolding mode. 

• In the Face on area to compensate field, select the external face of the stringboard. 

• In the Boundary edges field, select the four edges indicated below. TopSolid then understands which face it 
should extend. 

 

• Enter 100mm as the extension value. 

• Make sure that the  Extend connected edge mode is selected for the extension of borders. 

 

• Click on  to confirm the operation. 
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The unfolding result is as follows. 

 

• Confirm the in-place editing. 

We will now attach the stringboard to the steps. 

• Start a  quick search. 

• Enter 7380 as the keyword, select the Family type, search in the current project and its part numbers. 

 

• Select the first part number and drag and drop it into the graphic area. 

 

• Select the M6 x 20 code. 
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• In the Frame field, click on the  icon and select the  Frame on Shape command. 

• In the Shape field, select the stringboard. 

• In the Point field, select a point on the first drilling of the first step. 

  

• Click on  to confirm the creation of the frame on shape. 
 

• In the wizard, reverse the direction of the frame using the arrow as shown below, then add an offset of 4mm. 

   

• Click on  to confirm the wizard. 

• Select Clearance hole as the process. 

We will now include the washer. 

• Start a quick search. 

• Enter 7380 as the keyword, select the Family type, search in the current project and its part numbers. 

  



Part 2 - Designing a Spiral Staircase TopSolid'Steel - Advanced 

46   TopSolid 

• Insert the washer, select the code 6, then position the component as shown below. 

 

We will now include the nut. 

• Start a quick search. 

• Enter 1587 as the keyword, select the Family type, search in the current project and its part numbers. 

 

• Insert the nut, select the code M6, then position the component as shown below. 
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We will now add the same components on the second drilling of the step. To avoid having to search again, you can 
reinsert a component that is already there. 

• To do this, press and hold down the Ctrl key on the keyboard and drag the desired component while holding 

down the  left mouse button. 

 

• Select the Construction >  Repetition command. 

• In the Entities field, select the two screws, the two washers and the two nuts. 

• In the Pattern field, select the pattern of the steps. 

 

• Click on  to confirm the operation. 
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Part 3 - Designing and Using a Glass Partition Component 

The purpose of this exercise is to draw the following parametric glass partition, to integrate it in an environment 
resulting from a DXF/DWG import and to generate manufacturing drawings. 

 

Concepts addressed: 

- Importing a DXF/DWG file 
- Using steel joinery extruded bars 
- Creating and using families 
- Using automatic drafting bundles 
- Multiple unfoldings/draftings 

Importing the DXF/DWG 2D environment 

• From the Project tree, create a new folder named 3- Glass partition. 

The glass partition will be designed using extruded bars and document templates whose design principles will be 
described throughout the training. 

• In the 3- Glass partition folder,  Import the package named Glass Partition Files.TopPkg. 

• Right-click on the 3- Glass partition folder and select the Import/Export >  Import File with Conversion 
command. Select the file named Glass Partition Project Architect Drafting.A.0.dxf. 

TopSolid displays the different spaces contained in the DXF/DWG file as tabs. In most cases, only the object space 
is required. The other tabs can therefore be unchecked. 

The different layers can be selected on the left side of the screen. 

• Select Drawing from the Import as drop-down list. 

The drawing document is a non-associative 2D document that is perfectly suited for a DXF/DWG import. Although 
it is very basic, it allows you to manage large documents with better performance than when importing as a part or 
assembly. 
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• From the Options tab, check the settings of the following parameters. 

 

• Click on  to confirm the import. 

The drawing document is displayed in the foreground. 

It is advisable to clean the 2D imported files in order to remove the superimposed lines, to adjust the segments, 
etc. 

• Select the 2D Sketch > Healing >  Clean command. 

• Select the sketch and click on the  icon. 
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TopSolid displays the created lines and circles. 

 

The cleaning tolerance can be adjusted as required. 

• Click on  to confirm the operation. 

We will now isolate a cross section view to then integrate our future glass partition. 

Note: In addition to the cross section view, you can also use a top view to recreate a 3D environment as shown 
below. 

 

• From the Project tree, right-click on the 3- Glass partition folder and select the  Assembly command. 

• Rename the assembly document Glass partition establishment.  
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• In the drawing document, select the cross section view. 

 

• Right-click in the graphics area and select the  Copy command or use the Ctrl + C keyboard shortcut. 

• Select the Point option and select the point as shown below. 

 

• Click on  to confirm the operation. 
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• In the assembly document, right-click in the graphics area and select the  Sketch command. 

•  Position the sketch on the absolute XZ plane. 

• Right-click in the graphics area and select the  Paste command or use the Ctrl + V shortcut. 

• Select the Sketch origin option and make sure that you check the Fix box. 

• Click on  to confirm the operation. 

• Confirm the sketch. 

The imported drawing has a scale factor. In order to build on this drawing, you need to reset the dimensions of the 
sketches. 

• Select the Construction >  Transform command. 

• Select the two sketches and the plane as the entities to transform. 

• In the Transform field, click on the  icon and select the  Scaling Transform command. 

• In the Center field, select Absolute Origin Point and enter a factor of 80. 

• Click on  to confirm the transformation type, and then the transformation operation. 

•  Save the document (Ctrl + S). 

  



TopSolid'Steel - Advanced  Part 3 - Designing and Using a Glass Partition Component 

TopSolid   53 

Creating the glass partition 

Creating the frame 

The glass partition will not be created directly on an environment. It will be independent, which will allow you to 
store it in a library and use it in several projects. 

• In the 3- Glass partition folder in the Project tree, create a new  Assembly document named Glass partition. 

• On the XZ plane, create a sketch with the parameters as shown below. 

 

• On the outer frame, include the Folding Extruded Bar L extruded bars using the 34 x 30 x 15 x 2 code. 
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• Orient the extruded bars using the Orientation field, the positioning points and the Invert option so that the 
extruded bars are positioned as shown below with the blade pointing inwards. 

 

• Click on  to confirm the inclusion. 

• Add a Folding Extruded Bar T extruded bar using the 34 x 15 x 15 x 2 code on the center segment. 
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• Align the blades with those of the frame. 

 

• Click on  to confirm the inclusion. 

•  Save the document (Ctrl + S). 

• Perform  miter trims on the outer frame. 
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• Adjust the central crossbar with notches. To do this, right-click on one of the vertical uprights and select the 

 Use Process command. 

 

 

• Repeat the operation on the opposite side. 
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Creating the top filling 

• Create a  constrained linear pattern between points by entering a maximum spacing of 500mm and a 
thickness of 45mm. 

• Check the Create parameter box in the advanced options. 
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Notes: All repetitions have an Alternated numbering option which affects the way TopSolid will number the 
occurrences resulting from the repetition. This option will have a very strong impact on the way you design 
according to the selected mode. 

Examples: 

- Alternated numbering box unchecked: 

 

Standard continuous numbering. 
If the user performs an operation on the last extruded bar with the number 4 and the width changes from 2500mm 
to 2000mm, TopSolid will go into error since extruded bar 4 would no longer exist. 

- Alternated numbering box checked: 

 

Numbering that gives priority to the ends. 
If the user performs an operation on the last extruded bar with the number 2 and the width is changed from 
2500mm to 2000mm, no error will appear. 
In another case, the third extruded bar with the number 4 is modified on the 2500mm width. If the width increases 
to 3000mm, extruded bar number 4 moves to the fourth position instead of the third position. 

Alternated numbering also has some disadvantages. There is no ideal mode. Each mode has its own areas of 
application with the related advantages and constraints. 
  

Width = 2500mm Width = 2000mm 

1 2 3 4 

Width = 3000mm 

1 2 3 1 2 3 4 5 

Width = 2500mm Width = 2000mm 

1 3 4 2 

Width = 3000mm 

1 3 2 1 3 5 4 2 
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• Select the Modeling >  Extruded Bar command. 

• Select the Folding Extruded Bar T family and the 34 x 15 x 15 x 2 code. 

• Select the  Frame and Length mode. 

• In the Length field, enter the Height - HeightBase - 22.5 formula. 

• Use the Orientation field to align the blades. 

 

• Adjust the extruded bar on the central crossbar. To do this, right-click on the extruded bar and select the 

 Planar Trim command. 
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• Add a notching operation to both ends. To do this, right-click both on the central crossbar and top crossbar and 

select the  Use Process command. 

 

We will now integrate the glass. 

• Right-click on the face as shown below and select the  Sketch command. 

 

• Create a rectangle as shown below. 

   

• Confirm the sketch. 
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• From the Project tree, open the 3- Glass partition > Glass partition files > Laminated glass folders, then drag 

and drop the  Family document named Laminated glass – Geometric drivers into the graphics area. 

• Select the 44.2 (8.8mm) code. 

• In the Profile field, select the previously created sketch. 

• Enter a clearance of 3mm and an offset of 3mm. 

• Click on  to confirm the inclusion. 

The glass must be positioned as shown below. 
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We will now integrate the glazing beads. 

• Use the sketch to insert four Glazing Bead extruded bars using the 15 x 15 x 1.25 code. 

• Enter a vertical shift of 30mm. 

 

• Make sure that the positioning is correct. 

 

•  Save the document (Ctrl + S). 
  



TopSolid'Steel - Advanced  Part 3 - Designing and Using a Glass Partition Component 

TopSolid   63 

• Perform  main trims on the vertical glazing beads in relation to the lower horizontal glazing bead. 

 

• Perform  main trims on the vertical glazing beads in relation to the upper horizontal glazing bead. 
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• Select the Construction >  Repetition command. 

• Select the following folding extruded T bar as the entity and select the constrained linear pattern (in this case, 
Pattern 1). 

 

The glass and glazing beads will have an additional repetition occurrence compared to the T extruded bars. 

•  Pin the command's dialog box and click on  to confirm the operation. 
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• Select the glass and the glazing beads as the entities. 

• In the Pattern field, click on the  icon and select the  Linear Pattern command. 

• Select the Line by two points mode and select the points as shown below (starting point on the right). 

 

• In the Total count field, select the parameter created by the pattern of the T extruded bars from the drop-down 
list and add 1. 

We add 1 because the basic pattern is that of the interior uprights and it is necessary to have an additional glass. 

• Click on  to confirm the pattern and the repetition. 
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Creating the bottom filling 

• Right-click on the following face as shown below and select the  In Place Part command. 

 
 

• Draw the following rectangle. 
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• Add an  offset profile with a distance of 2mm toward the center of the rectangle. Make sure you check the 
Construction box. 

 

• Right-click in the graphics area with no active selection and select the  Sheet Metal on Sketch command. 

• Check the direction and enter a thickness of 1.5mm. 

 

• Click on  to confirm the operation. 
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• Right-click on the following face as shown below and select the  Flange command. 

 

• Right-click on the length arrow and select Bound > Plane. 

 

• Select the plane as shown below, then add an offset of 2mm. 
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• Right-click in the graphics area with no active selection and make sure that the following options are selected. 

 

• Click on  OK to confirm the operation. 

• Confirm the in-place editing of the part. 

Parameterizing the coating 

The purpose is to create a standard parameterized glass partition. It may be interesting to be able to manage its 
color. 

• Select the Construction > Parameters > Other Parameters >  Coating Parameter command. 

• Adjust the dialog box as shown below. 

 

• Click on  to confirm the operation. 
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We will now define the parts on which we will use this parameter and therefore apply this coating. 

• Select the Tools >  Parts Material and Coating command. 

• Adjust the following parameters: 

- In the Elements field, select all parts except the glasses. 
- Uncheck the Derive coating box. This indicates that you do not want to use the original coating of the 

extruded bar. 
- Uncheck the No coating box. 
- Select the Parameter option and the Coating parameter. 

 

• Click on  to confirm the operation. 
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Creating the family 

Before creating the family, it can be interesting to parameterize the description. In a project, if several glass 
partitions of different dimensions are inserted, the parameterization will allow you to know their dimensions in the 
bill of materials and thus to distinguish between them. 

• From the Operations tree, open the folder named Document name parameterization. 

• Right-click on the Parameterized (Name) operation and select the Others >  Insert Before command. 

• From the Entities tree, open the Parameters > System Parameters folders. 

• Right-click on the Description = "Glass partition" entity and select the Others >  Parameterized command. 

• In the Value field, enter the Glass partition W[Width] x H[Height] x B[HeightBase] formula. 

The convention for parameterization is as follows: 

- for parameters: [ParameterName]; 
- for TopSolid's system parameters: [$EnglishParameterName]. 

The list of system parameters is available in the TopSolid online help by pressing the F1 key when parameterizing 
the description or any other text. 

[$Author] Retrieves the author of the document. 

[$Code] Retrieves the code of the document. 

[$CreationDate] Retrieves the creation date of the document. 

[$Description] Retrieves the description of the document. 

[$ComplementaryPartNumber] Retrieves the complementary part number of the document. 

[$MajorRevision] Retrieves the major revision of the document. 

[$MinorRevision] Retrieves the minor revision of the document. 

[$ModificationDate] Retrieves the modification date of the document. 

[$Name] Retrieves the name of the document. 

[$PartNumber] Retrieves the part number of the document. 

[$Thickness] Retrieves the thickness parameter of the created sheet metal 
part. 

• Click on  to confirm the description parameterization. 

• Click on the  End inserting icon in the document's tab. 

•  Save the document (Ctrl + S). 
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The tab's name should now include the dimensions of the glass partition. 

• Right-click on the assembly document's tab and create a  Family document. 

The family documents will allow the glass partition to be declined in different dimensions/configurations. 

The following two strategies are possible: 

- Using codes: Predefined codes are integrated. Then, you only have to select the desired code and TopSolid 
will provide the right glass partition. This operation is ideal for users who want to have a catalog of 
references. 

- Using drivers: The designer of the family selects the parameters he wants to convert into drivers. 
Then, the driver values are provided and the family generates the associated component. 

For more flexibility, you can define codes as well as drivers. If a parameter is used in both cases, priority is given to 
the drivers. 
You can also have optional drivers. These optional drivers allow you to break free from the rigid framework of 
codes. 

Example: 

The glass partition has two codes: 

- Model A: 
o Height = 2500 
o Width = 2000 
o Base = 1000 

- Model B: 
o Height = 2000 
o Width = 1500 
o Base = 800 

From time to time, it may be necessary to use the Model A code, but you may want to enter a special width. In this 
case, the Width parameter will be both in the codes AND the optional drivers. Therefore, priority is given to the 
codes. 

• From the Entities tree, open the Generics folder which contains all the parameters of the glass partition. 

• From the Entities tree, drag and drop the Height parameter to the right of the Code column in the table at the 
bottom of the screen. 
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• Repeat the operation with the Width and HeightBase parameters. 

• In the code table, enter the following values: 

 

• To view the code, right-click on the first column and select View Instance. 

TopSolid generates the component in the graphics area. 

We want to be able to select the coating each time the component is used. 

• From the Entities tree's Generics folder, right-click on the Coating parameter and select Move to Drivers. 

• In the Drivers folder, double-click on the Coating parameter. 

• In the Description field, enter Glass partition coating. This allows an alternative name to be exposed to the 
parameter name to the family user. 

As explained above, we want to be able to enter a special width if necessary. 

• From the Generics folder, right-click on the Width parameter and select Move to Optional Drivers. 

• Repeat the operation for the Height parameter. 

• Rename the family Glass partition and check it into the vault. 

TopSolid checks all the referenced documents into the vault and also generates the various created codes. 
The instances generated by the family can be found under the family document in the Project tree. 

 

Future instances will be added to the sequence. 

Reminder: Here is a reminder of the different terms used: 

- Generic:  Part or assembly document (or  2D modeling) in which the component is modeled and 
parameterized. 

-  Family: Document that generates the different instances according to the defined codes and drivers. 
- Instance: Family result. It is very similar to the generic documents, except that it integrates the values 

selected by the user. 

• Close the Glass partition family and its generic Glass partition W2500 x H3000 x B1000. 
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Using the glass partition component 

• Open the Glass partition establishment assembly that was created at the beginning of the exercise. 

• From the Project tree, drag and drop the Glass partition family document into the graphics area. 

The architect designed a completely tailor-made glass partition. Codes are therefore useless in this context. 

• Open the Optional Drivers tab. 

• In the Width field, click on the  icon and select the  Distance Parameter command. 

• Enter GlassPartitionWidth in the Name field, select the Axis type and select the two axes as shown below. 

 

• In the Height field, click on the  icon and select the Associative value option. 

• Select the segment as shown below. 

 

Reminder: The Associative value option makes the value associative to the selection. If the architect's drawing is 
modified, the glass partition will also be modified. 

• Click on  to confirm the inclusion.  
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TopSolid switches to the positioning context. 

The glass partition is displayed in gray since it is the first element that was inserted in the assembly. Accordingly, it 
is positioned at the origin and is fixed. 

• Right-click on the glass partition and select the  Unfix command. 

The glass partition turns pink. 

• Using the Assembly >  Axis on Axis command, position the glass partition in place of the drawing as shown 
below. 

 

• Confirm the positioning. 

•  Save the document (Ctrl + S). 

The glass partition is complete and positioned in its environment. 

We will now produce some of the drafting documents. 



Part 3 - Designing and Using a Glass Partition Component TopSolid'Steel - Advanced 

76   TopSolid 

Automatic generation of the manufacturing folder (Work) 

Introduction 

TopSolid has a Work document which allows you to automate various actions: 

- Create folders 
- Export (PDF, DXF, DSTV, etc.) 
- Create documents: 

o Bills of materials 
o Draftings 
o Unfoldings 
o Drafting bundles 
o Machining/cutting 
o Nesting 
o Etc. 

- Perform actions in certain documents: 
o Create manufacturing indexes 
o Reinitialize the indexes 
o Etc. 

These actions call for processing and can be linked to each other. TopSolid'Steel is delivered with an example of 
how to create the structure below. 
 

 

Assembly 

Manufacturing documents 

Bills of materials 

Parts, 
assemblies, 
extruded bars, 
etc. 

Manufacturing index 

Sheetmetal 
unfoldings 

Unfoldings Draftings 

Extruded bar 
draftings 

Sheetmetal 
draftings 

Assembly 
draftings 

Sheets 

Extruded 
bars 

Cover page 

Sheetmetal Assemblies 

Extruded 
bars 

Assemblies Sheetmetal 

Fastener 
sheets 

Purchased 
sheets 

Sheetmetal 
sheet 
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This work starts directly on an assembly and runs automatically. It will: 

- Create a structure with folders directly in the Project tree. 
- Generate the following bills of materials: 

o Flat - Parts: Allows you to regroup parts with identical geometry and properties, then to generate the 
manufacturing index for the parts. 

o Flat - Parts for Manufacturing: Same as above, but displays the manufacturing indexes. 
o Flat - Assemblies: Allows you to regroup assemblies with identical properties, then generate 

manufacturing indexes for the assemblies. 
o Flat - Assemblies for Manufacturing: Same as above, but displays the manufacturing indexes. 
o Multi-level: Describes the hierarchical structure of the assembly with its sub-assemblies, etc. 
o Multi-level for Manufacturing: Same as above, but displays the manufacturing indexes. 
o Parts - Back References: Allows you to know in which assembly(s) each part is assembled. 
o Assembly - Back References: Same as above but for assemblies. 
o Sheet Metal for Manufacturing: Allows you to isolate the sheet metal parts with their manufacturing 

indexes. It also allows you to generate unfolding documents. 
o Extruded Bars for Manufacturing: Allows you to isolate the extruded bars with their manufacturing 

indexes. It also allows you to generate an automatic drafting document of the extruded bars. 
- Generate sheet metal unfoldings from the Sheet Metal for Manufacturing bill of material document. 
- Generate a drafting document by unfolding, then put all the elements in a drafting bundle. 
- Generate a drafting document by extruded bar from the Extruded Bars for Manufacturing bill of material 

document, then put all the elements in a drafting bundle. 
- Same but for the assemblies from the Flat - Assemblies for Manufacturing bill of material document. 
- Generate a cover page for the folder in the form of a drafting document in A3 format. 
- Create the sheets (BOM in drafting format: 

o fasteners used; 
o purchased elements (with the Production Type = Purchased property); 
o sheet metals. 

Note: This automated document package can be copied to be customized/completed. 

Use 

• Right-click on the Glass partition establishment assembly document's tab and select the  Work command. 
You can create the work document from the Glass partition establishment document in the Project tree. 

• Select the TopSolid’Steel – Bill of materials - Unfoldings - Draftings - Sheets - Drafting bundles template. 

• Confirm the default task quantity of 1. 

 

Note: The quantities are useful for nesting or using the optional TopSolid cutting modules. This dialog box can no 
longer be displayed by selecting Tools > Options > Work Manager > Tasks and unchecking the Manage nesting 
data box. 

TopSolid creates a new work document in the project, retrieves all the necessary templates and starts the process.
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Once completed, TopSolid displays the result of the work document, i.e. all of the documents produced 
automatically. 

 

You can display one view per treated task. This makes it possible to better understand the process sequences. 

• Select the  Treated tasks display mode. 

• Expand the Glass partition establishment node, then the Glass partition establishment – Extruded bars for 
Manufacturing node and finally the index 2 node. 

 

You will see that TopSolid generated a bill of materials from which it generated drawings, which it then inserted 
into a drafting bundle. 
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• Click on the Glass partition establishment drafting document's tab. 

 

The different fields are automatically filled in with the parameters entered in the project document. 
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• Click on the Draftings Bundle for Extruded Bars A4 Landscape (Auto) document's tab. This document is a drafting 
bundle. 

A drafting bundle is a set of draftings. TopSolid automatically regroups them to facilitate printing, checking and 
management. 

 

In this case, the draftings have a special format in order to insert a maximum of drawings on an A4 format while 
keeping a certain level of readability. Each drawing remains fully editable. 

• Double-click on the drafting document in the lower left corner corresponding to the folding extruded bar 
(index 6). 

The drawing switches to in-place editing. 
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In the first upper left frame, we will find the manufacturing index, the quantity and the section. 
Below are the main properties. 
In the center, there are two views of the extruded bar with: 

- Automatic interruption of the view (this avoids the operated areas such as drillings, cuts, etc.). 
- Automatic dimensioning of length/cutting angles. 
- Automatic dimensioning of the position of the drillings. 

The rest of the dimensioning must be done manually. 

Finally, on the right, there is a table of back references that allows you to indicate in which assembly(s) the extruded 
bars are assembled. In this case, out of the five extruded bars, all five will go into A1 assembly. 

• Add three dimensions for the notches. 

 

• Confirm the edition. 

The bundle is updated. 

• Click on the Draftings Bundle for Sheetmetal A4 Portrait (Auto) document's tab. 
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Here we find the unfoldings with a view, the manufacturing index, the quantity, the back references, etc. 

The main view includes: 

- the enclosing dimensionings; 
- the bending dimensionings; 
- bending notes in table form; 
- the automatic dimensioning of the position of the drillings. 

The rest of the dimensioning must be done manually. 

As for the extruded bars, the table of back references is also on the right. 

• Click on the Draftings Bundle for Assemblies A4 Landscape (Auto) document's tab. 

 

This last bundle concerns the sub-assemblies. 

An automatic indexing is created on the isometric view. 

The table at the bottom left displays the back references. If the assembly has less than 20 parts, a BOM table is 
displayed above the title block. 

The other three documents below are sheets. They are drafting documents that contain only one bill of materials. 

- Fastener sheet: Contains all the elements having a screw, nut, bolt function, etc. 
- Purchased sheet: Contains all the elements having the Production Type = Purchased property. 
- Sheetmetal sheet: Contains all the sheet metals. 
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As seen previously, the work document allows you to generate different manufacturing documents. To date, it does 
not allow the update of these documents in case of modification of the 3D. If needed, you must add the drawings 
manually or restart the complete generation. 

To cancel (= destroy) the previous documents, you simply have to proceed as follows: 

• Return to the work document named Work 1. 

• Click on the Processes tab. 
 

 
 
1: Available and usable processes 
2: Processes to be applied 
3: Configuration of the selected process 
4: Source(s) to be considered 
5: Template to be used and destination folder 
6: Process status 

• In the Executions (6) section, select all the processes (Ctrl + A) and click on the  Cancel icon. 

TopSolid warns that the documents will be destroyed and changes made to the documents will therefore be lost. 

• Click on  to confirm the cancellation of the processes. 

You can now restart the generation of the processes by using the  Execute command.  

1 2 

3 

4 

5 

6 
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Part 4 - Designing a Railing with Managed Sections 

The purpose of this exercise is to design a parametric railing while managing the sections thanks to the distribution 
command. 

 

Concepts addressed: 

- Using the Distribution command 
- Providing functions 
- Parameterization: 

o Setting conditions of parameters (when) 
o Setting conditions of operations 
o Using associative deletion 

Introduction 

The  Distribution command allows you to distribute one or two components alternatively with very numerous 
possibilities. 
In practice, on a railing, component 1 could be a post model and component 2 a filling model. At any time, these 
models can be replaced with other models that you would have designed. 
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The type of distribution also offers many possibilities. At any point, these variations can occur in the project in a 
few minutes. 
For example, you can (non-exhaustive list): 

- edit a type of post in the middle of the distribution (to create a section, for example); 

 

- remove a filling and modify the posts on either side; 
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- distribute at a fixed distance; the rest will also be either symmetrically distributed or stored on one side; 

 

- distribute with a maximum distance; 

 

- force the width of a filling. 

 

The disadvantage of this is a longer implementation time than what was seen with the railing in the Basics training. 

This parameterization becomes profitable in the following cases: 

- case with a railing model used in different configurations/dimensions; 
- work with a catalog of standardized posts and fillings; 
- case requiring great flexibility in implementation; 
- etc. 

In order to work, the distribution will require the following elements: 

- At least one component. This component can be a part or an assembly. In both cases, it must have a family. 
- Providing a special function to the generic document. This will allow you to define the positioning points, as 

well as the orientation and length variable of the component. 
- Providing a special function to the family. This will identify this family as distributable. 
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Importing components 

• From the Project tree, create a new folder named 4- Railing with sections. 

In order to focus on the distribution command and its use, the posts have already been modeled. 

• In the 4- Railing with sections folder,  import the package named Railing Files.TopPkg. 

The package contains the following documents. 

 

Configuring the post 

• From the Railing files > Posts folders, open the Post assembly document. 

• Select the Tools > Functions >  Provide Function command. 

• Select the Distributable Component function, check the Create parameter box, then click on  to confirm 
the operation. 

The following dialog box appears. 

 

The Top Right Point and Bottom Left Point fields will allow TopSolid to generate the different positioning points (9 
in total). 
The Additional Key Points field allows you to add more positioning points. 
The Frame field defines the orientation of the component. 
The Length field defines the usable length of the component when performing the distribution. 
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• Select the following two points on the plate. 

 

 

If the points had been aligned, only three positioning points would have been visible. 
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• In the Frame field, click on the  icon and select the  Frame by Point and 2 Directions command. 

• Adjust the fields as shown below. 

 

• Click on  to confirm the operation. 

The convention to be respected is the following: 

- The Z axis of the frame must be in the distribution direction. 
- The Y axis describes the vertical orientation. 
- The X axis describes the horizontal orientation. 
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• In the Length field, you can find the parameter that was created when providing function. Enter a value of 
15mm. 

 

In the case of a post, this value corresponds to the thickness of the post separating the fillings. 

• Click on  to confirm the operation. 

• Open the Post family document. 

• Select the Tools >  Provide Driving command. 

• Select Distributable Family and click on the  icon to move to the next step. 

• Select <Unspecified>. 

Indeed, we do not want TopSolid to ask us for the length. This is calculated by the component itself. In our case, it 
is fixed at 15mm. 

• Click on  to confirm the operation. 

Providing the Distributable Family driving indicates to TopSolid that this family is not a standard family. When the 
distribution command is launched, it will appear in the possible choices and, if the family is directly included in an 
assembly, the distribution command will be automatically launched. 

•  Save (Ctrl + S) and close the family and its generic.  
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Creating the filling 

• From the Project tree, create a new folder named Fillings in the 4- Railing with sections > Railing files folder. 

• Right-click on the Fillings folder and create an  Assembly document. 

• Rename the assembly document Alternating square bar filling. 

• Draw the following sketch on the XZ plane. 

 

• Select the Modeling >  Extruded Bar command. 

• Select the Full Flat Section, NF A 45-005 family and the 40 x 10 code, then select the following segments. 
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• Create the following  constrained linear pattern between points. 

• Select the  Step distribution mode, enter a step of 160mm and check the Center and Alternated numbering 
boxes. 
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Since the pattern is composed of two extruded bars, it will be necessary, in some cases, to remove the extruded 
bars located on the outside. 
To identify these particular cases, you have to measure the pattern. 

• Select the Construction > Parameters >  Distance Parameter command. 

• Select the Point mode and select the two points as shown below. 

 

The 75mm value allows you to define rules. For example, if the value is less than 61.5mm, the left extruded bar will 
be deleted. 
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• Draw the following sketch on the XZ plane. 

 

The 50mm and 110mm dimensions are centered on the first occurrence of the constrained linear pattern. 

• Select the Modeling >  Extruded Bar command. 

• Select the Full Square Section, NF A 45-004 family and the 14 code, then select the following segments. 

 

•  Save the document (Ctrl + S). 
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• Select the Construction >  Repetition command. 

• Select the two full square extruded bars as the entities. 

• Select Pattern 1 as the pattern to be used. 

 

• Click on  to confirm the operation. 

We will now have to deal with the particular case where the starting distance is less than 61.5mm. This is possible 
thanks to the distance parameter that was previously created. 

Note: You are probably wondering, why 61.5mm? How to know and anticipate this particular case? 

In the vast majority of cases, the answer is simple: you only have to use the component. Indeed, certain particular 
cases are obvious and can easily be anticipated. The other cases are discovered as the component is used. 
As a result, your component has to evolve, be corrected and optimized. This is an integral part of the 
parameterization work that could even be called "development". 
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• Select the Assembly >  Removing command. 

• Select the following two extruded bars. 

 

• Click on  to confirm the operation. 

This command, also called "associative deletion", creates a removing operation. 

 

In other words, this deletion is chronological. If the Modeling stage cursor is placed before the Removing 1 
operation, the extruded bars will be displayed. If the removing operation is deleted, they will be displayed again as 
well. 

• Right-click on the Removing 1 operation and select the Others >  Condition command. 

• Select the With condition option and enter the StartDistance<=61.5 formula. 

 

• Click on  to confirm the operation. 
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A suffix is added before the operation: 

- (?): The operation has a conditioning. The operation is active because its condition is also active. 
- (x): The operation has a conditioning. The operation is inactive because its condition is not respected. 

In this case, the operation is disabled because the StartDistance parameter value is greater than 61.5mm. 

The basic parameterization is now complete. You can vary the Length parameter for testing purposes. 

As with the post, you now have to make the filling distributable. 

• Select the Tools > Functions >  Provide Function command. 

• Select the Distributable Component function, uncheck the Create parameter box, then click on  to confirm 
the operation. 

• For the Top Right Point and Bottom Left Point fields, select the single point indicated below. 

 

Selecting the same point for these two fields can be useful when the object has only one positioning method, which 
is the case here. 

• In the Frame field, click on the  icon and select the  Frame by Point and 2 Directions command. 

• Fill in the fields as shown below. 

 

• Click on  to confirm the operation.  
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Reminder: 

- The Z axis of the frame must be in the distribution direction. 
- The Y axis describes the vertical orientation. 
- The X axis describes the horizontal orientation. 

• In the Length field, select the Length parameter. 

• Click on  to confirm the operation. 
 

• From the Alternating square bar filling assembly document, create a  Family document. 

• From the Entities tree's Generics folder, right-click on the Length parameter and select Move to Drivers. 

• Select the Tools >  Provide Driving command. 

• Select Distributable Family and click on the  icon to move to the next step. 

• Select the Length parameter. 

 

• Click on  to confirm the operation. 

•  Save (Ctrl + S) and close the family and its generic. 
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Using the distribution command 

We will now test our components and discover the possibilities of the distribution command. 

• From the Project tree, right-click on the 4- Railing with sections folder and create an  Assembly document. 

• Rename the assembly document Railing with sections. 

• Draw the following sketch on the XY plane. 

 

• Select the Modeling >  In Place Extruded Parts command. 

• In the Sections field, select the previously created sketch. 

• Enter a length of 200mm. 

 

 

• Still on the XY plane, create the following sketch. 
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• Select the Modeling >  Distribution command. 

The  Distribution command has the same positioning system as the Extruded Bar command: on profile, 

between points and frame + length.  

• Select the Two points mode and then select the points as shown below. 

 

The following two distribution modes are available: 

-  Mark out: When you indicate an element length, TopSolid distributes the element according to some 
strategies described below. 

-  Distribute: You indicate a quantity of elements to be distributed. 

• Select the  Mark out mode. 

Several remainder distribution modes are available: 

- Do not distribute: Fillings of 1200mm will be positioned and the remainder will remain empty. You can 
determine its position using the Remaining length option. 
 

o Start 

 

o End 
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o Symmetric 

 

- Fill remainder: Fillings of 1200mm will be positioned and the remainder will be filled with a shorter instance. 
You can indicate the minimum filling distance as well as the position of the remaining length. 
 

o Start 

 

o End 

 
 

o Symmetric 

 

- Distribute remainder: Fillings with a length greater than or equal to 1200mm will be positioned. 
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- Distribute one more: Fillings with a length less than or equal to 1200mm will be positioned. 

 

• Select the options below. 

 

The distribution is able to manage the distribution of two components simultaneously. In our example, the first 
component will be the post, the second will be the filling. 

• In the  First component section, select Post as the family. 

TopSolid preselects the center point. In our case, it is the center of the post. 

• Zoom in to select the point as shown below. 
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In the  Second component section, the following three modes are available: 

-  None: Only one component is distributed. 

-  Family: A family is distributed. 

-  Space: Empty spacings are managed. 

• Select the  Family mode. 

• Enter a length of 1200mm (filling length). 

• Select the Alternating square bar filling family. 

You should obtain the following result. 

 

Another characteristic of the distribution command is its ability to handle particular cases. You can therefore 
perform actions on each of the elements to be distributed such as: 

- replacing an element with a space; 
- replacing an element with another family; 
- forcing the length of an element; 
- modifying an element's parameters. 

• Right-click on label 1 and select Exception. 
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• Select the  Family mode and select the Left post family. 

 

• Click on  to confirm the operation. 

TopSolid replaces the post and adds a label that represents the exception. 

 

• Add an exception to label 3 by selecting the Right post family. 
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One solution to manage the railing sections is to use junction posts. 

• Add an exception to label 11 by selecting the Junction post family. 

 

TopSolid recalculates the entire distribution to obtain homogeneous fillings in order to take into account this 
difference in thickness. 

 

• Click on  to confirm the distribution operation. 
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• Modify the concrete length to 6500mm. The distribution is recalculated. 

To obtain correct railing sections, you have to replace a post with a junction post. 

• Edit the distribution operation. 

• Add an exception to label 9 by selecting the Junction post family. 

• Enter a length of 16mm. 

• Leave the distribution command active. 

Using sub-components 

To go even further in terms of flexibility and parameterization, you can modify certain sub-components without 
parameterization. This may involve modifying a driver parameter, a code or even the family directly. 

Let us take the case of our filling's bars. We want to switch to a 12mm section instead of 14mm. 

• In the  Second component section, click on the Sub-components button.  

The following dialog box appears. 

 

1 - Rules: You can define substitution rules using the functions and filters (see online help). 
2 - List of sub-components: The components displayed in gray cannot be modified directly. The other components 
can be selected and edited from the editing area (4). 
3 - Preview: It allows you to view the selected components, as well as the changes made. 
4 - Editing area: This area allows you to make changes to the components. The following three modes are available: 
 Global: All parts with the same function will be modified. 
 Exclusion: Allows you to define exclusions as part of a global modification. 
 Local: Only the selected element will be modified. 
5 - Substitutions: This area will contain the list of changes made. 
6 - Update: Two modes are available: Automatic or Manual. 

For more information, you can consult the TopSolid online help by clicking on the  icon or by pressing the F1 key 
on your keyboard. 
  

1 
3 

2 

5 

4 

6 
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• Select the extruded bar as shown below. Check the Local tab and select the 10 code. 

 

• Check the Automatic Update box. All the right bars are updated. 

Note: To modify the left bar, you have to resize the railing so that it appears or you have to make a global 
modification. 

•  Confirm to finish editing the sub-components. 

All fillings are modified. If we had wanted to modify only one of them, it would have been necessary to create an 
exception and then use the Sub-components option. 

• Click on  to confirm the distribution operation. 

•  Save the document (Ctrl + S). 
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Adding the handrail 

• Select the Modeling >  Extruded Bar command. 

• Select the Hollow Circular Section, ISO 4019 family and the 48.3 x 2 code. 

• Select the Between points mode and position the extruded bar as shown below. 

 
 

 

It is now necessary to trim the handrail at each junction post. Another possibility would have been to include three 
extruded bars, one for each section. 
This second method, although slower, is more interesting if you plan to modify the ends of the handrail by 
performing miter trims or other means. Indeed, a trimming operation by keeping the trimmed side is faster, but 
makes it impossible to use the cutting commands. 

• Select the Modeling >  Trim command. 

• Select the Plane mode, check the Keep trimmed side box, and then select the middle face of the first junction 
post. 

 

 

• Click on  to confirm the operation. 



TopSolid'Steel - Advanced  Part 4 - Designing a Railing with Managed Sections 

TopSolid   109 

TopSolid asks you to select a derivation template. 

• Select the Part - 0mm (Extruded bar, Derivation, Mirror, Partial part) template. 

• Click on  again to confirm the operation. 

Note: The selected template is specific to extruded bars. It integrates many parameterizations for only extruded 
bars. For example, it can parameterize the name of the extruded bar by integrating its length (see the Project tree), 
calculate the cutting angles and lengths, produce the symbol for the orientation of the cuts, etc. 
Make sure you select the right template because, once you have used it, you can no longer change it. In our case, 
if an error occurs, the only solution is to remove the trimming operation and perform it again using the right 
template. 

Important: In case of derivation for modification or trimming while keeping the trimmed side, it is advisable to use 
the Part - 0mm (Extruded bar[...]) template. 

• Repeat the trimming operation on the second junction post. There should now be three handrails. 
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Defining the sub-assemblies (in-place assemblies) 

• Right-click on the Railing with sections assembly document's tab and select the  Bill of Material command. 

• Select the Multi-level template from the Steel Standard Templates - United States folder and click on  to 
confirm the operation. 

• In the Assembly dialog box, make sure that the Groups by properties box is checked and click on  to confirm 
the operation. 

• Rename the bill of materials Railing with sections - General. 

As you can see, the bill of materials contains all the elements without any real organization. Indeed, the Distribution 
command is transparent; it does not produce a sub-assembly. This allows the grouping of parts/sub-assemblies as 
desired. 

We will exclude the concrete part from the bill of materials. 

• Right-click on the Part line and select the  Open Document command. 

• Select the Construction > Parameters > Type for BOM command. 

• Select the Absent type. 

• Click on  to confirm the operation. 

•  Save (Ctrl + S) and close the document. 

• Return to the Railing with sections assembly document. 

The junction posts were brought in one go to save time and facilitate the calculation of the distribution. You have 
to “split” them up since one portion will be welded on the left section and the other portion on the right section. 
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• Select the Modeling >  Disassembly command. 

• Select first junction post. 

 

•  Pin the command's dialog box and click on  to confirm the operation. 

• Disassemble the second junction post. 

 

We will now create the sub-assemblies. 

• Select the Modeling >  In Place Assembly command. 

• Create the following three sub-assemblies. 
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The parts of the junction posts are divided between the sections as shown below. 
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• Create another in-place assembly which contains the three sections. 

Warning: If the length of the railing is modified, you will have to edit the in-place assemblies to add the new parts. 
You may also need to add/remove junction posts and disassemble them. 

•  Save the document (Ctrl + S). 

• Return to the BOM document. 

• Rename the three sub-assemblies Start section, Intermediate section and End section, as well as the railing 
assembly. 

Additional exercises 

Creating a side return 

 

Railings very regularly have returns on their ends. These are very varied and, depending on the needs, so is the 
method for designing them. 

Two strategies are possible: 

- integrate the angle into the distribution (exercise); 
- put the angles first, then create the distributions on each side. 

• From the Project tree, create a new folder named Returns in the 4- Railing with sections > Railing files folder. 

• From the 4- Railing with sections > Railing files > Posts folders, copy the Left post family and assembly 
documents. 

• Paste these documents into the previously created Returns folder, then rename them Left return. 

• Open the Left return assembly document. 

• From the Operations tree, move the Modeling Stage cursor before the Frame by Point and 2 Directions (Frame 
3) operation. 
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• Create the following sketch on the XY plane. 

 

Note: Do not forget to create the two Length1 and Length2 parameters. 

• Select the Construction >  Frame by Point and 2 Directions command and create the following frame (Z on 
the absolute Z axis and X on the absolute X axis). 

 

• Repeat the operation by creating the following frame (Z on the absolute Z axis, X on the absolute Y axis). 
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• Select the Construction >  Repetition command. 

• Select the post and its plate as the entities. 

• Create a  pattern on frames. 

• Select the first frame as the source frame and the second frame as the destination frame. 

 

• Click on  to confirm the pattern, and then the repetition. 

You should obtain the following result. 
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• Select the Modeling >  Extruded Bar command. 

• Select the Full Flat Section, NF A 45-005 family and the 40 x 10 code, then select the sketch. 

 

• Add a vertical offset of 45mm (or -45mm according to the indicated direction). 
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• Repeat the operation for the upper extruded bars by entering an offset of 895mm. 

 

• Add two miter trims. 
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• Add main cuts in relation to the posts. 

 

You should obtain the following top view result. 
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To make it easier to fix the second post, it would be ideal if the drilling of the plate was oriented toward the inside 
of the railing. TopSolid has quick modification tools to “transform” the objects. 

• Select the Construction > Transforms >  Transform command. 

• Select the second plate as the entity to transform. 

 

• In the Transform field, click on the  icon and select the  Rotation Transform command. 

• As the rotation axis does not exist, you have to create it. To do this, in the Axis field, click on the  icon and 

select the  Middle Axis command. 

• Select the two following axes. 

 

• Click on  to confirm the middle axis. 

• In the Angle field, enter 180°. 

• Click on  to confirm the axis, the transformation pattern and the transformation operation. 
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You should obtain the following result. 

 

• Right-click on the following face and select the  In Place Part command. 

 

• Create the following sketch. 
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• Right-click in the graphics area with no active selection and select the  Sheet Metal on Sketch command. 

• Enter a thickness of 1.5mm. 

• In the Limit field, select Plane and select the lower face of the top rails. 

• Check the  Bends section and select the  Thickness mode. 

• In the  Thickness Distribution section, enter a shifting factor of 0.5mm. 

 

• Click on  to confirm the operation. 

• Confirm the in-place editing. 

• Return to the assembly document and click on the  icon in the document's tab. 
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In order for the component to be inserted at the right position, you have to reposition the distribution frame. 

• To do this, edit the Frame by Point and 2 Directions (Frame 3) operation. 

• Select the point as shown below as the origin. 

 

• Click on  to confirm the operation. 

• Edit the operation providing the Distributable Component function. 

• In the Length field, enter Length1. 

• Click on  to confirm the operation. 

•  Save (Ctrl + S) and close the document. 

• Open the Left return family document. 

• From the Entities tree's Generics folder, right-click on the Length1 and Length2 parameters and select Move 
to Drivers. 

•  Save (Ctrl + S) and close the document. 

Using the side return 

• Return to the Railing with sections assembly document. 

• From the Operations tree, edit the Distribution 1 operation. 

• Right-click on the exception with number 1 and select Exception. 

 

• In the Family field, select Left return.  

• Click on  to confirm the operation. 

The next operations consist in repeating the previously performed steps (distribution, exception, handrail and 
creation of sub-assemblies). 

A variant of the side return could have been possible if we had wanted it to be disassembled. Instead of starting 
from the left post, we could have used the junction post as the base file. The return would then have been 
disassembled.  
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Part 5 - Steel Furniture 

The following exercise is an introduction to the staging of objects. This first step allows you to become familiar with 
the creation of specific materials with textures and coatings or to add a mechanism to an object, in this case a door. 

 

Concepts addressed: 

- Creating and applying textures, materials, coatings and finishings 
- Cutting a sheet metal part from a vectorized text 
- Applying a coating locally on a face 
- Creating a mechanism on an imported hardware 
- Creating configurations and projection in a drafting document 

Importing the steel furniture 

• In the Project tree,  import the package named 5- Steel Furniture.TopPkg. 

 

• Open the Steel furniture assembly document. 

 

TopSolid has several render modes. The shading render mode is the default render mode and allows you to apply 
colors and degrees of transparency to the parts, regardless of the materials and coatings. 
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• Select the Realistic Render Mode with Effects and Edges mode. 

 

Note: If you encounter display problems or if the Realistic Render Modes menu is not available, you have to check 
the compatibility of your graphic card with the TopSolid recommendations. 
The realistic render mode consumes a lot of graphic resources. Depending on the hardware installed, delays may 
occur. 

 

The selected rendering level makes it possible to see the final design. It can also be used in a drafting document. 
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Creating a new textured material 

A material is created in two steps: 

- Creation of the texture documents: one for the color and one for the relief (optional). 
- Creation of the material document in which the physical properties of the material as well as its rendering 

are defined. 

• Right-click on the 5- Steel furniture > Materials folder and select the  Document command. From the 

Advanced tab, select  Texture and use a blank template. 

• Rename the document Corten Steel. 

• In the Parameters section, click on the  button to the right of the Bitmap field and select the Corten Steel.jpg 
file. 

• Modify the width to 500mm. This value corresponds to the actual size of the image. 

•  Save (Ctrl + S) and then close the document. 

We will now create the texture that will give relief to our texture. Depending on the materials, the relief strongly 
changes the rendering. 

Without relief With relief 

  

• Right-click on the 5- Steel furniture > Materials folder and select the  Document command. From the 

Advanced tab, select  Texture and use a blank template. 

• Rename the document Corten Steel - Bump. 

• In the Category field, select Bump. 

• In the Parameters section, click on the  button to the right of the Bitmap field and select the Corten Steel - 
Bump.jpg file. 

• Modify the width to 500mm. This value corresponds to the actual size of the image. 

•  Save (Ctrl + S) and close the document. 

We will now create the material that will contain the two previously created textures. 

• Right-click on the 5- Steel furniture > Materials folder and select the  Document command. 

• From the Advanced tab, select  Material and use a blank template. 

• Rename the document Corten Steel. 

• In the Description field, enter Corten Steel. 

• In the Category field, select Carbon steel. 

The category choice is important. The category provides quick access to the desired material and defines the 
hatching style in the drafting document. 
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• In the Density field, enter 7.85kg/dm3. 

• In the Texture field, select Corten Steel. 

• In the Bump texture field, select Corten Steel - Bump. 

• In the Bump scale field, enter 1. This value allows you to accentuate the bump effect. The higher the value, the 
more visible the relief will be. 

• In the Specularity type field, select Metal. 

 

•  Save (Ctrl + S) and close the document. 

Using the new material 

• Return to the Steel furniture assembly document. 

• From the Parts tree, click on the  Hide All icon. 

• In the  column, check Frame. 
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• Select the Tools >  Parts Material and Coating command. 

• Select all the parts that are visible on the screen. 

• Uncheck the Derive material box. As a reminder, this allows you not to use the material used when creating 
the library. 

• In the Category field, select Carbon steel. 

• In the Material field, select Corten Steel. 

• Click on  to confirm the operation. 

 

• From the Parts tree, click on the  Show All icon. 

•  Save the document (Ctrl + S). 
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Creating a new coating 

TopSolid allows you to apply a layer called "coating" on a material. This type of document is used to add a 
galvanization, a paint or a specific treatment. 
This coating can be applied globally on one or more parts (by using the same command as before) or locally on a 
batch of faces belonging to the same part. 

• Right-click on the 5- Steel furniture > Materials folder and select the  Document command. 

• From the Advanced tab, select  Coating and use a blank template. 

• Rename the document Powder coating RAL 3020. 

• In the Description field, enter Powder coating RAL 3020. 

• In the Category field, select Paint. 

• Click on the Diffuse color button and enter the following values: 

- Red: 204 
- Green: 6 
- Blue: 5 

These values are available on the Internet by typing the keywords "RAL RGB". 

• In the Specularity type field, select Metal. 

 

•  Save (Ctrl + S) and close the document. 
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Applying a local coating 

• Return to the Steel furniture assembly document. 

• Double-click on the following part to edit it in place. 

 

• Select the Shape > Other Operations >  Coating command. 

• In the Faces field, select the face as shown below. 

• Select Paint in the Category field and select Powder coating RAL 3020 in the Coating field. 

 

• Click on  to confirm the operation. 

You should obtain the following result. 
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Cutting a sheet metal part from a vectorized text 

Cutting a sheet metal part from a text requires the use of a special Windows font. In fact, standard fonts cannot be 
used because some sections of the different letters would fall off (O, P, Q, B, etc.). 

• In Windows Explorer, in the training folder, double-click on the LaserCutOldStyle.ttf file. 

• Click on the Install button at the top left of the window. This action adds a new font to Windows. This font will 
be available in all applications using Windows fonts (TopSolid is one of them). 

Note: On some computers, it may be necessary to restart TopSolid, sometimes even the computer itself. 

• In TopSolid, switch back to the in-place editing context of the red sheet metal part. 

• Create a new sketch on the face painted in red. 

• From the 2D Sketch tab, select the  Text command. 

• In the Text field, enter TopSolid'Steel or any other text of approximately the same length. 

• Check the Profiles box. This option allows you to convert a text into profiles (vectorization). 

• In the  Format section, check the Font box and click on the button below. 

• Select the LaserCutOldStyle font, enter a height of 10mm and click on  to confirm the operation. 

• Check the Expansion box and enter 1.2. This option enlarges the text by 20% (x1.2). 

• Position the text approximately in the center of the plate. 

. 

• Click on  to confirm the text creation. 

• Right-click on the text and select the  Annotation Centering command. 

• Select the left vertical edge of the red plate, and then the right vertical edge. 

TopSolid moves to the next centering. 

• Select the text, the upper horizontal edge, then the lower horizontal edge. 

The text should turn blue. 
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• Right-click in the graphics area with no active selection and select the  Trim by Profile command. 

The arrow indicates the direction of the trimmed side. 

• Make sure that it is pointing toward the inside of the text. 

 

• Click on  to confirm the trimming operation. 

• Confirm the in-place editing. 
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Additional exercise: Importing a hinge and creating a mechanism 

In metalworking, you sometimes need to simulate a mechanism such as the opening of a door, a gate, a trap door, 
etc. 

There are many benefits: 

- explain a movement to your customer; 
- facilitate the teams' understanding of a mechanism; 
- know enclosing dimensions, displacements, etc.; 
- facilitate the design of complex mechanisms. 

In most cases, these mechanisms are given by accessories (hinges, rack and pinions, slides, etc.). The scenario to 
animate a design is the following (with the example of the piece of furniture): 

- Importing the hinge. 
- Creating the rigid groups (groups of parts that do not move with each other). There are two rigid groups in 

a hinge. 
- Adding the joint between the rigid groups. We can define which movement is possible between the rigid 

groups. 
- Designing the furniture with its hinges. 
- Creating the rigid groups to link the different groups of accessories with the different parts of the furniture. 
- Creating configurations (open doors, closed doors, half-open doors, etc.). 

• From the Project tree, create a new folder named Hinge in the 5- Steel furniture > Accessories folder. 

• Right-click on this new folder and select the Import/Export >  Import File with Conversion command. 

• Select the file named Welded Steel Hinge - Fixed Axis - Steel Axis 37-720-60.A.0.stp. 

The import dialog box is displayed. 

• In the Simplification and sewing tab, check the Simplify geometry box.  

• In the Templates tab, click on the  button to the right of Part template. 

• Select Project Templates > Defaults > Part and click on  to confirm the operation. 

• Click on the  button to the right of Assembly template. 

• Select Project Templates > Defaults > Assembly and click on  to confirm. 

• Click on  to confirm the import. 

Note: To import the manufacturers’ 3D components, we recommend the following formats: 

- Step (.stp) 
- Parasolid (.x_t) 
- AutoCad 3D (.dxf/.dwg) 

Other formats can be used but the geometries can be altered, which may hinder their use in TopSolid. 
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• Edit the properties of the imported assembly and fill in the fields as shown below. 

  

The Assembly type for BOM property allows you to select the assembly structure in the bill of materials. The 
following four modes are available: 

- Absent: The hinge will not be included in the bill of materials. It will still be part of the parent assembly. It 
will be projected in the drafting document and its mass will be taken into account.  

- Composite: The hinge and the parts that make it up will be visible in the bill of materials. It is the default 
mode used in TopSolid. 

- Simple: Only the hinge will be included. This is the ideal mode for commercially available components. This 
allows you to simply display the line containing the manufacturer's part number and not the detail of the 
sub-parts which have no interest in a bill of materials. 

- Transparent: Only the parts making up the hinge will be visible. This mode is widely used to create groups 
of parts that are easier to insert in one go. For example, a screw and its washer, an extruded bar and its seal. 
The assembly is not necessary in a bill of materials. Its parts and sub-assemblies are instead preferred. 

In the User properties tab, the Production Type property allows you to perform sorts and filters. For example, the 
result can be a bill of materials of all the purchased components, sorted by manufacturer and by reference. 

• Click on  to confirm the properties. 
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• Open the assembly named Welded Steel Hinge 37-720-60. 

• Select the Mechanism >  Mechanism command. 

• Click on  to confirm the Mechanism dialog box. 

A Ground Group rigid group is created by default. It is the reference element of our assembly. All parts are currently 
located in this rigid group. 

• Select the Mechanism >  Rigid Group command. 

• Select the entity as shown below. 

 

• Click on  to confirm the operation. 

We will now define the joint between the two rigid groups. 

• Select the Mechanism >  Revolute command. 

• Select Ground Group from the drop-down list or directly from the graphics area as the first rigid group. 

• Select Group 1 as the second rigid group. 

• Select the hinge axis as the rotation axis. 

 

• Click on  to confirm the operation. 

•  Save (Ctrl + S) and then close the document. 
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Using the hinge and the mechanism 

• Return to the Steel furniture assembly document. 

• Insert the hinge to be welded and position it as shown below. 

 

TopSolid uses the degrees of freedom of the mechanism. This allows you to orientate each part of the hinge toward 
the two supports (the frame and the door) on which it will be welded. 

• Select the Construction >  Repetition command. 

• Select the steel hinge to be welded as the entity. 

• Create a  symmetrical pattern. 

• Select Plane as the symmetry type, then create a  midplane between the upper face and the lower face of 
the furniture. 
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• Select Translation as the transform type, then select the transform origin as shown below. 

 

• Click on  to confirm the pattern and the repetition. 
 

• Repeat all the operations for the hinges of the right door: 

- inclusion and positioning of the hinge; 
- repetition of the hinge by reusing the previously created pattern. 

We will now create the mechanism. 

• Select the Mechanism >  Mechanism command. 

• Click on  to confirm the operation. 

• Select the Mechanism >  Rigid Group command. 

• In the Name field, enter Left door. 

• Select the left door and the two upper sections of the hinges. 

 

• Click on  to confirm the operation. 
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• Repeat the procedure on the right side by naming the rigid group Right door. 

 

The revolute joints are already defined since they have been retrieved from the different hinges. Nevertheless, you 
need to inform TopSolid that the lower sections of the hinges are fixed to the frame. 

• Select the Mechanism >  Merge Rigid Groups command. 

• Select the ground as the rigid group to keep and select the lower section of one of the hinges as the rigid group 
to absorb. 

 

• Repeat the procedure for the three other hinges. 

We will now open the doors to be able to use different configurations in the drafting document. 

• Select the Mechanism >  Constrained Configuration command. 

You can perform actions directly on the doors by sliding them. 

• Add a Point on plane positioning constraint as shown below. 
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The objective is to put the door in contact with the frame to represent the maximum opening. 

• Confirm the configuration context. 

• Select the Mechanism >  Constrained Configuration command to create a new configuration. 

• On the same door, add an  orientation constraint by selecting the following two elements. 

 

• Confirm the configuration context. 

From the Mechanism tab, you can switch from one configuration to another using the drop-down menu on the 
right. 

 

• From the Entities tree's Mechanism > Configurations folders, rename configuration 1 Open left door and 
configuration 2 Half-open left door. 
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Drafting the constrained configurations 

• Create a drafting from the steel furniture using the Assembly A3 ISO Landscape template from the Steel 
Standard Templates - United States folder. 

• Position the first view. 

• Before confirming the operation, click on the icon shown below until the view switches to realistic rendering 
mode. 

 

 

• Click on  to confirm the main view. 

• Add the following two views. 

 

The design configuration is projected by default. At any time, you can use another configuration or even overlay 
other configurations. 

• Right-click on the main view and select the  Edit Set command. 

• Click on the Auxiliary configurations button. 

• Select the two configurations on the left and click on the  icon. 

• Click on  to confirm the operation, and then the set editing.  
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You should obtain the following result. 

 

You can set dimensions to these representations and configure their appearance using the view style (auxiliary line).  
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Annex 1 - Creating a Sheet Metal Extruded Bar (Coping) 

The purpose of this exercise is to design a sheet metal extruded bar using different dimensional parameters. The 
example will be a coping of the following type. 

 

Concepts addressed: 

- Creating a parameterized sketch 
- Sheet metal commands 
- Creating an extruded bar using the Extruded bar function 

• From the Project tree, create a new folder named A1- Coping. 

• Create a  Part document in the A1- Coping folder. 

• Rename the part document Coping. 

• Create the following sketch. 
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• Right-click in the graphics area with no active selection and select the  Sheet Metal on Sketch command. 

• Enter Thickness=1mm in the Thickness field. 

• Enter Length=100mm in the Length field. 

• Check the Bends section and select the  Thickness mode. 

 

• Click on  to confirm the operation. 

• Select the Tools > Functions >  Provide Function command. 

• Select the Extruded Bar function. 

As with the distributable component, TopSolid needs two points to facilitate the positioning. 

• From the Entities tree, display the sketch that was used to create the sheet metal part (Sketch 1 normally). 

• Select the following points as the top right point and bottom left point. 
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To facilitate the positioning of the extruded bar, you can select additional positioning points. 

• Click in the Additional Key Points table and add the following points. 

 

TopSolid asks you to enter a description for each point. 

• Simply add a number. 

• Select Absolute Frame as the frame and the Length parameter as the length. 

• Click on  to confirm the function. 

We will now parameterize the description of the component in order to integrate the Code parameter. 

• From the Operations tree, move the Modeling Stage cursor as shown below. 

 

• From the Entities tree's Parameters > System Parameters folders, right-click on the Description parameter and 

select the Others >  Parameterized command. 

• In the Value field, enter Coping [$Code]. 

We could have also added all the part's dimensions: 

Coping [A] x [B] x [C] x [D] x [E] Th[Thickness] 

• Click on  to confirm the description parameterization. 

• In the document's tab, click on the  End inserting icon. 

•  Save the document (Ctrl + S). 
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• Right-click on the part document's tab and create a  Family document. 

• From the Entities tree's Generics folder, drag the C parameter into the table containing the codes. 

• Enter the following values in the table. 

 

• From the Entities tree, select the Length, Thickness, A1, A, B, D and E parameters. 

• Right-click and select Move to Drivers. 

• Right-click on the C parameter and select Move to Optional Drivers. 

As a reminder, this last manipulation will allow you, if necessary, to create widths that are not included in the 
catalog codes. 

•  Save (Ctrl + S) and close the family document and its generic. 

We will now use the new extruded bar. 

• In the A1- Coping folder, create an  Assembly document. 

• Draw the following sketch. 

 

Note: Values are not important. 

• Add the Coping extruded bars as shown below. 
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• Add two miter trims. 

 

•  Save (Ctrl + S) the assembly document. 

• Produce a sheet metal bill of materials using the Sheet Metal template from the Steel Standard Templates 
folder. 

You should obtain a cutting list for the different copings. The bill of materials could have been of the extruded bar 
type in the case of standard copings purchased in lengths. 
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Annex 2 - Creating an Extruded Bar from a DXF Section 

The purpose of this exercise is to design an extruded bar based on a DXF/DWG section from a process development 
engineer. 

 

Concepts addressed: 

- DXF/DWG import 
- Creating an extruded bar using the Extruded bar function 

• From the Project tree, create a new folder named A2- Folding extruded bar L. 

• Right-click on the A2- Folding extruded bar L folder and select the Import/Export >  Import File with 
Conversion command. 

• Select the Folding Extruded Bar L.dwg file. 

• Select Part from the Import as drop-down list. 

• From the Options tab, check the settings of the following parameters. 
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• In the Templates tab, click on the  button to the right of Part template. 

• Select Project Templates > Defaults > Part and click on  to confirm the operation. 

• Click on  to confirm the import. 

The drawing document is displayed in the foreground. 

• Select the 2D Sketch > Healing >  Clean command. 

• Select the sketch and click on the  icon. 

TopSolid displays the created lines and circles. 

• Click on  to confirm the operation. 

The imported DWG file contains many lines that are not necessary to build the 3D extruded bar. 

• Create a new sketch and select the  Contour Wizard command. 

• Click on one of the outer contour's edges. 

 

TopSolid automatically detects the contour. 

• Repeat the operation with a segment of the inner contour. 
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You should obtain the following result. 

 

• Right-click in the graphics area with no active selection and select the  Extruded command. 

• In the Length field, enter Length=100mm and check the Center box. 

 

• Select the Tools > Functions >  Provide Function command and select the Extruded Bar function. 

• Select the following points as the top right point and bottom left point. 
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• Click in the Additional Key Points table and add the following points. 

 

TopSolid asks you to enter a description for each point. 

• Simply add a number. 

• Select Absolute Frame as the frame and the Length parameter as the length. 

• Click on  to confirm the function. 

To make it easier to design with extruded bars, you can add a simplified representation. 

• To do this, create the following sketch. 

 

• Right-click in the graphics area with no active selection and select the  Extruded command. 

• In the Length field, enter Length=100mm and check the Center box. 

• From the Entities tree's Representations folder, edit the simplified representation. 

• Uncheck Shape 1 and check Shape 2, then click on  to confirm the operation. 
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From the Tools tab, you can then switch from one representation to another. 

   

•  Save the document (Ctrl + S). 

• Right-click on the part document's tab and create a  Family document. 

• From the Entities tree, right-click on the Length parameter and select Move to Drivers. 

•  Save (Ctrl + S) and close the family document and its generic. 

This extruded bar can be used as in the previous annex and as the other TopSolid standard extruded bars. 
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Annex 3 - Creating a 3D Environment from 2D Drawings 

In the glass partition exercise (part 03), we saw how to work from a 2D DXF document. You can assemble several 
2D views to create a 3D document. 

 

• Open the Glass Partition Project Architect Drafting.A.0 document located in the 3- Glass partition folder. 

• Select the view shown below. 
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• Right-click in the graphics area and select the  Copy command or use the Ctrl + C keyboard shortcut. 

• Select the Selection center option and click on  to confirm the operation. 

• In the new assembly document, right-click in the graphics area and select the  Sketch command. 

• Right-click in the graphics area and select the  Paste command or use the Ctrl + V shortcut. 

• Select the Sketch origin option and make sure that you check the Fix box. 

• Click on  to confirm the operation. 

• Delete any lines from the adjacent views (in this case, at the bottom left and right). 

 

• Confirm the sketch. 

• In the drawing document, select the section as shown below. 
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• Right-click in the graphics area and select the  Copy command or use the Ctrl + C shortcut. 

• Select the Point option and select the point as shown below. 

 

• Click on  to confirm the operation. 

• In the assembly document, select the Construction >  Plane by point and normal command. 

• Select the point as shown below and the -X axis as the normal. 

 

• Right-click on the previously created plane and select the  Sketch command. 

• Right-click in the graphics area and select the  Paste command or use the Ctrl + V shortcut. 

• Select the Sketch origin option, make sure that you check the Fix box, and then click on  to confirm. 

The imported drawing has a scale factor. In order to build on this drawing, you need to reset the dimensions of the 
sketches. 

• Select the Construction >  Transform command. 

• Select the two sketches and the plane as the entities to transform. 

• In the Transform field, click on the  icon and select the  Scaling Transform command. 

• In the Center field, select Absolute Origin Point and enter a factor of 80. 

• Click on  to confirm the transformation type, and then the transformation operation. 

•  Save the document (Ctrl + S).  
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Annex 4 - Creating a Cutting List of Extruded Bars 

TopSolid allows you to create single drawings as well as assemblies of several drawings thanks to the  Drafting 
Bundle document. 

There are many benefits: 

- grouping of several drawings to facilitate printing; 
- creation of technical files; 
- creation of A0 drawings composed of drawings of different formats (A4, A5, A3, etc.); 
- creation of cutting files; 
- creation of labels. 

The purpose of this exercise is to obtain the following result. 

 

• From the Project tree, open the 3- Glass partition > Glass partition files folders and copy the Templates 
(annexes) folder (the Ctrl + C keyboard shortcut or selecting the Copy command via the contextual menu). 

• From the Project tree, paste the folder into the Templates folder (the Ctrl + V keyboard shortcut or selecting 
the Paste command via the contextual menu). 

 

• Rename the folder Templates - Training Technical File.  
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In the basic training, we saw that it is better to store the document templates in the My Templates or Company 
Templates folders in the case of a server installation. Indeed, it is the recommended location for templates that 
concern the company. 

Nevertheless, you will sometimes have to create specific document templates for a case (custom title block, layout 
imposed by the customer, etc.). These templates will have to be stored in the project, which has just been done. 

• Right-click on the Glass partition establishment assembly document's tab and select the  Bill of Material 
command. 

• Select the Extruded Bar template from the Steel Standard Templates - United States folder, then click on 

 to confirm the operation. 

• In the Assembly dialog box, make sure that the Groups by properties box is checked and click on  to confirm 
the operation. 

• Rename the bill of materials Glass partition establishment - Extruded bars. 

• Select the  Multiple Draftings command. 

The following dialog box appears, listing all the lines of the bill of materials. TopSolid detects if a drawing already 
exists or if you have to create it. 

 

• Uncheck Glass partition establishment. 

• Double-click on the template of the first part. 

TopSolid invites you to select the drafting template to be used for this part. 

• Select Project Templates > Templates - Training Technical File > Extruded Bar Drafting for Bundle. 

 

• Click on  to confirm the operation.  
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You now have to apply this template to all parts. 

• Right-click on the template on the first line and select Apply the template to checked documents. 

 

• Click on the Options tab. 

• In the Parts section, select the Specified folder option and click on the  button. 

• In the 3- Glass partition folder, create a new folder named Extruded bar draftings and click on  to confirm 
the operation. 

• In the Nest draftings section, check the Create drafting bundle box and click on the  button to the right 
of Drafting bundle template. 

• Select Project Templates > Templates - Training Technical File > Automatic Drafting Bundle and click on  to 
confirm the operation. 

 

As you can see with the different options, this command also allows you to update the bundle by adding, deleting 
or updating the different drawings. 

• Click on  to confirm the operation. 
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• Open the  Glass partition establishment - Extruded bars drafting bundle from the 3- Glass partition folder. 

 

A drafting bundle can be compared to a classic assembly in which each part would be a drawing. As with an 
assembly, you can therefore edit a drawing in place by double-clicking on it or open it by right-clicking on it and 

selecting the  Open Document command. 

• Double-click on the first drawing from the top to edit it in place.  
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The drawing switches to the in-place editing mode. 

 

• Select the  Interrupted View command. 

• In the View field, select the left view. 

• In the Profiles type field, enter Line. 

• Position the lines as shown below. 

 

• Click on  to confirm the operation. 
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• Select the command again and repeat the operation for the right view. 

• Select the Interrupt like mode using the left view as the reference. 

 

• Click on  to confirm the operation. 

You can optimize the scaling factor according to the view layouts defined in the document. 

• Select the  Optimize View Layout command. 

You should obtain the following result. 

 

• Confirm the in-place editing to return to the bundle document. 

•  Save the document (Ctrl + S) and close it. 
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Annex 5 - Creating and Exporting Sheet Metal Unfoldings (Multiple 
Unfoldings) 

TopSolid allows you to generate multiple unfoldings from a simple bill of materials. These unfoldings can be 
exported very easily in DXF/DWG format. This is what we will see in this exercise. 

• Right-click on the Glass partition establishment assembly document's tab and select the  Bill of Material 
command. 

• Select the Sheet Metal template from the Steel Standard Templates - United States folder and click on  to 
confirm the operation. 

• In the Assembly dialog box, make sure that the Groups by properties box is checked and click on  to confirm 
the operation. 

• Rename the bill of materials Glass partition establishment - Sheetmetal. 

• Select the  Multiple Unfoldings command. 

The following dialog box appears. 

 

The bill of materials already contained only sheet metal parts. If it had not been the case, the command would have 
proposed only the sheet metal parts to create the unfoldings. 

As with the multiple drafting operation, TopSolid checks if an unfolding does not already exist and offers a selection 
of document templates to be used. 

• In the Destination section, select the Specified folder option and click on the  button. 

• In the 3- Glass partition folder, create a new folder named Unfoldings and click on  to confirm the operation. 

• In the Options section, make sure that the Open after creation option is checked, then click on  to confirm 
the operation. 

 

TopSolid generates as many unfolding documents as there are sheet metal parts. 

You can export the complete batch in the desired format (DXF/DWG for example). 

• To do this, from the Project tree, open the 3- Glass partition > Unfoldings folders, then right-click and select the 

Import/Export >  Export Several Documents with Conversion command. 
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• Select the desktop as the destination, select Name.Major.Minor.Extension as the naming convention, select 
AutoCad as the part translator, and select DWG as the format. 

 

• Click on  to confirm the operation. 

The files are created. 

• Click on  to confirm the operation a second time to exit the dialog box. 
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Annex 06 - Creating a Cutting List of Sheet Metal Parts 

The objective is now to produce the following drafting bundle. 

 

• Right-click on the Glass partition establishment - Sheetmetal BOM document's tab and select the  Multiple 
Draftings command. The following dialog box appears. 

 

• Uncheck Glass Partition Establishment. 
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• Double-click on the template of the first part. TopSolid invites you to select the drafting template to be used 
for this part. 

• Select Project Templates > Templates - Training Technical File > Part Drafting for Bundle. 

 

• Click on  to confirm the operation. 

Since the bill of materials contains only one part, you do not have to apply this template to all the parts. 

• Click on the Options tab. 

• In the Parts section, select the Specified folder option and click on the  button. 

• In the 3- Glass partition folder, create a new folder named Sheetmetal draftings and click on  to confirm. 

• In the Nest draftings section, check the Create drafting bundle box and click on the  button to the right 
of Drafting bundle template. 

• Select Project Templates > Templates - Training Technical File > Automatic Drafting Bundle and click on  to 
confirm. 

 

• Click on  to confirm the operation. 
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• Open the Glass partition establishment - Sheetmetal drafting bundle from the 3- Glass partition folder. 

 

• Double-click on the drawing. 

 

A drawing contained in a bundle can be resized at any time. The whole document will be automatically recalculated. 

• Right-click in the graphics area with no active selection and select the Format command. 

• In the Dimensions section, adjust the height to 100mm and click on  to confirm the operation. 

 

• Confirm the in-place editing. The positioning is recalculated. 

• Edit the drawing in place again. 

• Right-click in the graphics area with no active selection and select the  Scale command. 

• Adjust the scale to 1/30. 
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• From the Project tree, drag and drop the unfolding document into the drafting document. 

• Select the  Automatic Dimensions command on the unfolding to display its enclosing dimensions. 

 

• Select the  Automatic Bend Notes command and position the notes as shown below. 

 

• Confirm the in-place editing to return to the bundle document. 

•  Save the document (Ctrl + S) and close it.  
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Annex 7 - Creating a 2D Symbol of the Post Cutting 

The purpose of this exercise is to draw a 2D parametric component to cut the railing posts. 

 

Concepts addressed: 

- Creating a 2D parametric symbol 
- Creating a family 
- Using a 2D symbol for design 

Creating a 2D parametric symbol 

• From the Project tree, create a new folder named 6- 2D cutting symbol. 

• Right-click on this folder and select the  Document command. 

• From the Special tab, select  2D Modeling, then select the 2D Symbol template from the Standard 
Templates - United States > Standard Components folder. 

• Rename the document Cutting symbol for post. 

• Right-click in the graphics area with no active selection and select the  Sketch command. 

• Draw the following sketch. 
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Here are some additional guidelines to create the sketch: 

- The circle must be in construction mode. To do this, right-click on the circle and select the  Construction 
command. 

- The PostWidth dimension is centered on the Y axis. 
- The two segments below coincide with the center of the circle. 

 

• Confirm the sketch. 

By default, the symbol is positioned via the absolute frame's point. You can add other positioning points. 

• Select the Construction >  Midpoint command to create the following point. 

 

• Right-click on the previously created point and select the Others >  Publish Point command. 

• In the Name and Description fields, enter Cutting height point, then click on  to confirm the operation. 

• From the Entities tree's Publishings folder, edit the Center (Center) publishing. 

• In the Name and Description fields, enter Handrail center, then click on  to confirm the operation. 

Note: To modify the default positioning point, you simply have to move the publishing up or down. The lowest 
publishing is the one by default (in this case, Handrail center). 

• Select the  > File >  Virtual Document command. 

• Check the Virtual Document box, then click on  to confirm the operation. 

This option allows you to hide the document in the drop-down menus and searches. Indeed, the user should only 
see the family and not the family and the generic. 
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• Right-click on the Cutting symbol for post document's tab and create a  Family document. 

• From the Entities tree's Generics folder, hold down the Ctrl key and select the CuttingHeight, PostWidth and 
HandrailDiameter parameters, then right-click and select Move to Drivers. 

•  Save (Ctrl + S) and close the family document, as well as the 2D modeling document. 

Using the 2D parametric symbol 

• From the Project tree, right-click on the 6- 2D cutting symbol folder and create an  Assembly document. 

• Select the Modeling >  Extruded Bar command. 

• Select the Full Flat Section, NF A 45-005 family and the 50 x 15 code. 

• Select the  Frame and Length mode. 

• In the Destination frame field, select Absolute Frame. In the Length field, enter 1000mm. 

 

• Click on  to confirm the operation. 
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• Create a sketch on one of the following faces. 

 

• Select the  Symbol command. 

• Select Cutting symbol for post as the model and select Cutting height point as the key point. 

• Make sure that the Fix orientation and Profiles boxes are checked. 

• Position the symbol as shown below. 

 

• Confirm the sketch. 
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• Right-click on the sketch and select the  Trim by Profile command. 

 

• Click on  to confirm the operation. 

At any time, you can change the values of the symbol or even replace it with another one. 
Symbols can also be used in a drafting document. They can either be scaled to the projection set's scale, or to the 
paper's scale. 
  



TopSolid'Steel - Advanced  Notes 

TopSolid   171 

Notes 

 .........................................................................................................................................................................................................................................................  

 .........................................................................................................................................................................................................................................................  

 .........................................................................................................................................................................................................................................................  

 .........................................................................................................................................................................................................................................................  

 .........................................................................................................................................................................................................................................................  

 .........................................................................................................................................................................................................................................................  

 .........................................................................................................................................................................................................................................................  

 .........................................................................................................................................................................................................................................................  

 .........................................................................................................................................................................................................................................................  

 .........................................................................................................................................................................................................................................................  

 .........................................................................................................................................................................................................................................................  

 .........................................................................................................................................................................................................................................................  

 .........................................................................................................................................................................................................................................................  

 .........................................................................................................................................................................................................................................................  

 .........................................................................................................................................................................................................................................................  

 .........................................................................................................................................................................................................................................................  

 .........................................................................................................................................................................................................................................................  

 .........................................................................................................................................................................................................................................................  

 .........................................................................................................................................................................................................................................................  

 .........................................................................................................................................................................................................................................................  

 .........................................................................................................................................................................................................................................................  

 .........................................................................................................................................................................................................................................................  

 .........................................................................................................................................................................................................................................................  

 .........................................................................................................................................................................................................................................................  

 .........................................................................................................................................................................................................................................................  

 .........................................................................................................................................................................................................................................................  

 .........................................................................................................................................................................................................................................................  

 .........................................................................................................................................................................................................................................................  

 .........................................................................................................................................................................................................................................................  



Notes TopSolid'Steel - Advanced 

172   TopSolid 

 ..........................................................................................................................................................................................................................................................  

 ..........................................................................................................................................................................................................................................................  

 ..........................................................................................................................................................................................................................................................  

 ..........................................................................................................................................................................................................................................................  

 ..........................................................................................................................................................................................................................................................  

 ..........................................................................................................................................................................................................................................................  

 ..........................................................................................................................................................................................................................................................  

 ..........................................................................................................................................................................................................................................................  

 ..........................................................................................................................................................................................................................................................  

 ..........................................................................................................................................................................................................................................................  

 ..........................................................................................................................................................................................................................................................  

 ..........................................................................................................................................................................................................................................................  

 ..........................................................................................................................................................................................................................................................  

 ..........................................................................................................................................................................................................................................................  

 ..........................................................................................................................................................................................................................................................  

 ..........................................................................................................................................................................................................................................................  

 ..........................................................................................................................................................................................................................................................  

 ..........................................................................................................................................................................................................................................................  

 ..........................................................................................................................................................................................................................................................  

 ..........................................................................................................................................................................................................................................................  

 ..........................................................................................................................................................................................................................................................  

 ..........................................................................................................................................................................................................................................................  

 ..........................................................................................................................................................................................................................................................  

 ..........................................................................................................................................................................................................................................................  

 ..........................................................................................................................................................................................................................................................  

 ..........................................................................................................................................................................................................................................................  

 ..........................................................................................................................................................................................................................................................  

 ..........................................................................................................................................................................................................................................................  

 ..........................................................................................................................................................................................................................................................  

 ..........................................................................................................................................................................................................................................................  

 ..........................................................................................................................................................................................................................................................  



TopSolid'Steel - Advanced  Individual Course Evaluation Form 

TopSolid   173 

  
 ..

...
...

...
...

...
...

...
...

...
...

...
...

...
...

...
...

...
...

...
...

..
...

...
...

...
...

...
...

...
...

...
...

...
...

...
...

...
...

...
...

...
...

...
...

...
...

...
...

...
...

...
...

...
...

...
...

...
...

...
...

...
...

...
...

...
...

...
...

...
...

...
...

...
...

...
...

...
...

...
...

...
...

...
...

...
.. 

 

  
 ..

...
...

...
...

...
...

...
...

...
...

...
...

...
...

...
...

...
...

...
...

..
...

...
...

...
...

...
...

...
...

...
...

...
...

...
...

...
...

...
...

...
...

...
...

...
...

...
...

...
...

...
...

...
...

...
...

...
...

...
...

...
...

...
...

...
...

...
...

...
...

...
...

...
...

...
...

...
...

...
...

...
...

...
...

...
.  

0 1 2 3 4 5 6 7 8 9 10 
 

Individual Course Evaluation Form 
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Name :  ..........................................................................................................................................................  

Company :  ..........................................................................................................................................................  

Date(s) from  ................................................................  to  ............................................................................  
 
By completing this individual evaluation form, you are helping to improve the quality and usefulness of the training provided in the future. Please complete it 
carefully. 

 
Number of people during the course:  Onsite at your company? YES □ NO □ 
 
 GENERAL ASSESSMENT  Poor Average Good Excellent 
 Overall, this course has been: □ □ □ □ 
 

What grade would you assign?  

 
 LOGISTIC   Poor Average Good Excellent 
Orientation (quality, organization, user-friendliness, etc.) □ □ □ □ 
Physical setup (room, materials, etc.) □ □ □ □ 
 
 TRAINING  Poor Average Good Excellent 
Instructor's teaching method □ □ □ □ 
Group relationship (participation, sharing of experiences) □ □ □ □ 
Quality and clarity of educational materials (documentation) □ □ □ □ 
Balance between Theory and Practice □ □ □ □ 
Consistent presentations with what has been announced □ □ □ □ 
Training Content □ □ □ □ 
 
 DURATION  No Somewhat no Somewhat yes Yes 
Does the overall duration of the course seem appropriate? □ □ □ □ 
If no, was it? Too short □ Too long □ 
 
 PACE   No Somewhat no Somewhat yes Yes 
Does the overall pace of the course seem appropriate? □ □ □ □ 
If no, was it? Too slow □ Too fast □ 
 
 USE OF ACQUIRED KNOWLEDGE IN THIS TRAINING  No Somewhat no Somewhat yes Yes 
Have you found this training to be useful in your work? □ □ □ □ 
Do you think you can put the acquired knowledge into use quickly? □ □ □ □ 
Do you believe that you have achieved your objectives  

upon completion of this course? □ □ □ □ 
 

Comments and suggestions:  ..........................................................................................................................................................  
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